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Creating a Poster or Banner

Introduction.
This program was initially created to allow my daughter to generate large posters for 
use in presentations for her 4-H club and school.    The posters are text and graphics.    
After creating a poster, she prints in double size (4 sheets of paper) and pastes it onto a
poster board.    For a typical presentation, she will use six to ten posters.    

The program has been enhanced to make it more generally applicable to a broad range 
of uses - all dealing with printing large posters and signs which are not supported by 
standard Windows word processors and graphics programs.

Shape.
Select VERTICAL to make a poster that is taller than it is wide.
Select HORIZONTAL to make a poster that is wider than tall.
Select BANNER to make a long, narrow banner.

Editing: 
To create a poster or banner simply begin typing in the information. The default font and
character size are setup to get you going immediately.    You can use the fonts menu to 
select other fonts, and the 'text' menu to change the size and other characteristics.

You can edit your poster like any other windows word processor.    

Graphics:
You can create graphics in 3 ways:
1. Using OLE and the "Insert Object" command: 
Use the "Edit" "Insert Object" command to start an OLE server like Draw, Paintbrush, 
etc. After you create the object, exit the program; the picture will be pasted into your 
poster.
2. Pasting from the Windows Clipboard.
Create graphics with 'Draw', 'Paintbrush' or some other program, and then copy them 
into the windows clipboard.    Then, in the poster program, you can paste them into your 
poster. You may also use a clipart program, such as Corel Gallery. 
3. Import graphics files.
Import bitmap files (*.bmp files) or windows metafiles (*.wmf files). Metafiles are 
recommended, as they will scale smoothly when enlarged and printed.    Bitmaps will 
generally look jagged when enlarged and printed.      
Graphics can be used as a picture inserted into the text, or a border or background.

Size:
Each poster is 1 page on the display screen - usually 8 1/2 x 11 inches (21.6 x 28 cm.) -
when you create it; but when you print it, you scale it up to be as big as you want (up to 
9 feet - 266 cm. - wide or high)!
Each banner can be up to 21 inches wide on the screen, but it prints 5 times bigger, 
making it 105 inches (almost 9 feet -    266 cm.) wide.

Printing:
When you are done, save the poster, and then print it.    You can print it as a single 
sheet, or up to ten times bigger (which takes 100 sheets of paper).    You then have to 
paste the sheets together to make a single, big poster or sign.



 
Support and Registration - version 1.5

If you have any problems or suggestions, send me a note.    My email address is 
Internet: BobBedoll@aol.com; AOL: BobBedoll; Compuserv: 71754,2174. 

I encourage you to register this program if you find it useful.    Registration is a paltry $8,
which is pretty reasonable for a program like POSTER; this helps cover my costs for 
distribution and support.    

If you register, you are entitled to full support, future upgrades, and a disk of fancy 
borders.    It also helps make me a happy camper. To register:

From Compuserv: GO SWREG
By Mail: Send $8 to: Poster Software

Bob Bedoll
11002 48th St. E.
Puyallup, WA, 98372

Bob Bedoll



Printing
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General

To print a poster or banner, select Print in the "File" menu.
 
Posters:

To print a single page exactly as it looks on the screen, select "1 page".

To print a double size poster, which is actually 4 sheets of paper, select the "2X" option.  
Everything on the poster, including all the text and all the graphics, will be automatically 
printed in double size.    This is a good size to use if you are going to paste the poster 
onto standard size 'poster board'.

The text will be printed with smooth lines.    However, the graphics may look ragged 
because there is no way to smooth the lines in the picture.

To print bigger posters, select the "3x", "4x", etc. option. Everything on the poster will 
automatically be scaled up. You can print a poster up to six times as big as a single 
sheet of paper - this will require 36 sheets of paper.

Banners:

The banner is setup with a default print scale factor of 5x.    This will print a banner that 
is 7.5 inches    high (1 page high) and up to 105    inches wide (19 cm x 266 cm). This 
gives a standard banner.

You may select other print sizes to give you different effects.

Preview.
The preview option will show you exactly how the poster will look on the printed page, at
the scale you have selected.    Each rectangle corresponds to a printed page.

Margins. 
The Poster program assumes that the maximum printable area on a page of standard 8 
1/2 x 11 paper is actually 7 1/2 by 10 inches (19 x 25.4 cm) - in other words, it puts a 1/2
inch (1.3 cm) margin around the entire page.    
So, for a 1x poster of standard size, the actually printed size is 7 1/2 x 10 inches (19 x 



25.4 cm).
For a 2x poster, the actual printed size is 15 x 20 inches (38 x 50.8 cm), and so on.

POSTER determines the size of the paper you are using from the paper selection you 
make in your Printer Setup. So, if you are using 8 1/2 x 14 inch paper    (legal size) for 
example, POSTER will automatically take that into account.    POSTER always leaves a 
1/2 inch margin all around each page.

To change the margin between the text and the edge of the printed poster, use the 
"Page"->"Size and Margins" dialog box.

To override the default page size and page margin:
Select "Print" -> "More".    The dialog box will show the page size and page margin FOR 
EACH SHEET OF PAPER.    You may change these items to fine-tune how POSTER 
prints on your printer.    
PRINT PREVIEW will show the effect of changing the page size of each sheet.    
Changing the MARGIN affects where on each sheet POSTER prints the image.
These settings reset EVERY TIME you select PRINT.

Dot-matrix printer users: to print over the fold, try setting top/bottom margin to zero, OR 
try setting a very long page size.

Pasting pages together.

Each page will be printed separately, and the pages must be pasted together.    This is 
true even for a dot-matrix printer.    To help you do this, you can specify 'alignment 
marks'.

Alignment Marks.    

There are two different kinds of alignment marks:
Registration marks: small marks will be printed in each corner of each page.    By lining 
these marks up when pasting the pages together, you can get accurately placed pages.
Cut lines: dotted lines are printed on each edge which must be pasted to another edge.

Custom Sizes.

If you want a poster size other than an even multiple of your page size, you may set a 
custom size.    The poster will be scaled up as you requested, and printed on as many 
sheets of paper as necessary to hold the scaled up poster.    (Note that the printable 
area of each page remains as the size of one sheet of paper, minus a 1/2 inch margin 
on each side. BUT - you may change this with the "MORE - Page size and Margins" 
entry)

Possible entries:

One of the following can be set, and it causes the other two to automatically be set:

SCALE FACTOR: A decimal number between 1.0 and the maximum indicated on the 
menu.    This is a multiplier, not a percent. (To make the poster twice as big, use 2.0, not 
200).      
Example: A scale factor of 5.5 multiplies the page height and width by 5.5, so the 
standard size poster (7.5 x 10) becomes 41.25 x 55 inches.



WIDTH: A decimal number between 1.0 and 105.0 specifying the width of the poster, in 
inches or centimeters.    The height will automatically be set, based on the original size 
of a single page.

HEIGHT: A decimal number between 1.0 and 105.0, specifying the height of the poster, 
in inches or centimeters.    The width will automatically be set, based on the original size
of a single page.    

Printing Method.

If you are having trouble printing the poster, try the alternate printing methods.    These 
will cause all text to be sent to the printer as a bitmap graphic, rather than as 
characters; this seems to help some printer drivers which loose characters at page 
edges.
If your printer is dropping characters at the end of pages when you print at 2x or greater,
then check    one of the alternate printing methods. If you get postscript errors or color 
errors, try this also.

Method A and B are two different approaches to printing the poster text (graphics are 
not affected).    Each is more successful on different types of printers.    Try method A 
first; if that fails, try B.    If they all fail, send me a note.
.
Note: Checking A or B will usually slow down printing.

Color.

POSTER will print in color if your printer and printer driver support it.    All graphics, 
borders, and text will print in the same colors as shown on the screen - within the 
capabilities of your printer.

Printing a Single Sheet.

To print a single sheet of a multi-sheet poster, select PRINT->MORE.    Then enter the 
page number of the sheet you want to print. Pages are numbered in rows from left to 
right, then top to bottom.    Page 1 is in the upper left-hand corner.    You may use 
PREVIEW to ensure that you are printing the correct sheet.

Print Each Page Immediately.

When this box is checked (default), each page is sent to the printer as soon as it is 
generated.    Each page becomes a separate print file.
CLEAR this box to put all pages into a single print file (the standard Windows 
treatment).      This is useful when:
 1. Sending a FAX. (Otherwise each page is a separate fax).

2. Sending to a network printer that generates a banner page for each print job.

Printing Problems.

If you are having problems printing, see the special printer instructions below.    If these 
don't work, try selecting "Method A" or "Method B"    in the "Printing Method "box.
Finally, send me some email if neither of these work for you!



Special Printer Instructions.

LASERJET III USERS.
If the posters you print are missing characters at page edges, then do the following:
1. In the PRINT dialog box, check the button marked "Method A".    
Also, be sure your printer is set to 300 dpi.

LASERJET 4 USERS.
To successfully print posters, you must configure your printer as follows:
1. From the control panel, select printers, select 'Setup':
2. Set resolution to 300 dpi. (At 600dpi, printing takes a very long time, and may hang 
the printer.)
3. Select "options". 
4. Select "Graphics Mode" = "raster", "Graphics Quality"="high", and
          check "print true-type as graphics".
5. Close the control panel.
6. Start "POSTER".
If posters still do not print properly, then in the PRINT dialog box, check the button 
marked "Method A". This should always work.

POSTSCRIPT PRINTER USERS.
Poster may be unable to set the printer to horizontal or vertical page orientation. If 
"Preview" shows that the paper is not properly oriented for your poster, use the "Print 
Setup" selection to set the Page Orientation manually.

If you get postscript errors, or you are loosing characters at page boundaries:
1. From the control panel, select Printers, then select 'Setup.
2. Select "options", then select "advanced".
3. Select "print true type fonts as" "Bitmap (type 3)".
4. Close the control panel.
5. Start POSTER.
If posters still do not print properly, or print too slow, then in the PRINT dialog box, check
the button marked "Method A". 



Changing Fonts.

To change fonts, highlight the desired text and then pull down the "Font" menu and click
on the desired text. 

If you select a font without first highlighting text, the font applies to subsequent 
characters you type in.

The font menu is automatically filled with pictures of all the true-type fonts you have 
installed.    If you have more than 68 fonts, select the "more..." menu item - this will bring
up a separate font selection box.

BIGGER/SMALLER.

These enlarge or reduce the font size by 0.25 inches each time.    If the font is 0.25 
inches or less, each size increment is 0.05 inches.

For METRIC, these enlarge of reduce the font size by 0.5 cm.

SIZE.

This selects the size font to use.

Important: font sizes are always entered relative to a single size, 8 1/2 x 11 page. For 
example, a 1 inch font would be 1 inch high when printed at 1x,
but if you print at 2x (for a 17 x 22 inch poster), your 1 inch fonts will actually be 2 
inches high.

You may use the 'custom size' entry in the font menu to make a font of any size, up to 
the maximum printable size of a single page (usually 7 1/2 x 10 inches).
Again, if you scale the poster up when you print it, your font will scale up in the same 
manner.

Type-1 fonts, the kind supported by Adobe Type Manager, are NOT supported.    Bitmap 
fonts and vector fonts (like 'Modern') are also not supported.    (If you really want to see 
these supported, then let me know).

If you want to use fancy fonts, there are many sources for them.    Most bulletin boards 
contain many decorative true-type fonts, which can be down-loaded at no cost.      
Collections such as "Key Fonts Pro" feature over 1000 fonts for about $20.

Color.

You can select the color to display and print text by using the "Color" menu in the "text" 
pull-down menu.    The text will be printed in the same color as it is displayed - within the
capabilities of your printer.    POSTER retains the color as a full-color (24 bit) value; the 
display driver and printer driver then interpret this value and come as close to it as they 
can.



Adding Graphics.

You may add a picture in 3 ways: 
1) paste the picture in from the Windows clipboard.
2) Use the "Insert Object" command to start an OLE server like DRAW.
3) import a picture from a *.bmp file or *.wmf file.

You may also import a picture to use as a border or background.    See BORDER.    To 
do this, select the "Border..." menu item.

Other topics:
Resizing
Color
Display
Background

Using the Clipboard.

To add a picture, create it using Draw, Paintbrush or any other windows drawing or 
painting package. Then,    copy the picture to the Clipboard.    (If you have a choice of 
the format for the clipboard, choose 'Picture'). In Poster, put the cursor where you want 
the picture, then from the "Edit" menu, select "Paste from Clipboard".    The picture will 
be pasted in place.    

POSTER supports two types of graphics: Picture (metafile) and Bitmap.

      A PICTURE (metafile) is generated by drawing programs (Draw, Corel Draw, 
Designer) and some clipart packages (Corel Gallery). A PICTURE is actually a set of 
instructions to Windows to create a graphic using lines and curves.    When a PICTURE 
is enlarged for printing, it will usually enlarge very smoothly, and generate a high-quality 
image.

          A BITMAP is generated by painting packages (Paintbrush) and many clipart 
packages, as well as most scanners.    A BITMAP is simply a collection of bits (or pixels).
When you print a BITMAP, each bit is enlarged to become multiple bits. Hence, a 
BITMAP will usually look quite jagged when it is enlarged for printing.

    Pictures (metafiles) are usually preferred to bitmaps because they enlarge better.

Importing a bitmap file or metafile.

To import a graphic in a bitmap (*.bmp) file or metafile (*.wmf), select the 'Import 
Graphic' from the File menu.    
"Picture" will paste the picture in place at the current cursor position.    
"Border" will use the graphic as a border for the poster. The graphic is stretched to fill 
the entire page.
"Background" is similar to "Border", and allows the graphic to be a full-page background
for the poster.    The graphic is always stretched to fill the entire page.

A dialog box will then appear, allowing you to specify the file containing the graphic.    



A metafile must be a 'placeable metafile', or a file with a 'placeable header'.

NOTE: If the graphic is too big to fit on the poster within the poster margins, the entire 
graphic will be compressed to make it fit.    Often, pictures imported from a file contain a 
lot of extraneous white space which makes it difficult to use in Poster.    To fix this, import
the picture into 'Paintbrush', then paste the portion of the picture you want into the    
Clipboard.    Then, in Poster, Paste from Clipboard to insert the picture.

Preview.
The "Automatic Preview" box instructs POSTER is automatically display a preview of 
the graphic in a file when you click on that filename.
If you turn "Automatic Preview" off, you can still preview a file by clicking on the 
PREVIEW button.    This will display the last file selected, or the file name you have 
typed in.

Inserting an OLE Object.

You may use the OLE capabilities of programs like Draw, Paintbrush, WordArt, etc., to 
easily insert a picture into Poster.    To insert a picture, select "Edit" and "Insert Object".   
This starts the OLE server program.    When your picture is created, exit the OLE server,
and presto, the picture appears in Poster.    
        To Edit the picture, double click on it - this will restart the OLE server with your 
picture. 
        To resize the picture, select it and then select "Edit" "Resize".    Do NOT double click
on the object, as this will restart the OLE server.

Manipulating the Picture.

Once it is pasted in place, a graphic is treated like a very big character - the picture will 
move with the rest of the text in the poster.    

Deleting.
To delete a picture, use the DEL or Backspace key, just like deleting text.

Resizing.
To resize the picture, select the picture, then select 'Resize Picture' in the "Edit" menu.    
For pictures which are not OLE objects, you may also double-click on the picture. Move 
the mouse to resize the picture.    You may also reset the picture to its original size using
the 'Reset Picture" option.

Displaying.
By default, a dashed rectangle shows the outline of the picture - this box is never 
printed.    To turn off the box, see the options menu.
Displaying a metafile can take a long time.    You may wish to turn off the display of 
these graphics - but still print them.    To do so, see the Options menu.

Limits
You may have up to 64 different pictures in one poster.

Creating graphics
Any program which will allow a metafile (picture) or bitmap to be copied into the 
Windows Clipboard can be used to create a graphic.    If you want to import clipart files 



in formats such as *.TIF, you must first import them into a program like Paintbrush, 
Corel Draw,    or Write, and then copy them to the Clipboard.

Saving
When a poster is saved, the pictures are saved along with it.
When a poster is reloaded, the pictures are reloaded with it.
CAUTION: This can make for some very big 'save' files.

Backgrounds.
When a picture is imported as a background, it is stretched to fill the entire page.    The 
only way to delete a background is to import another background, or to go to the 
BORDER dialog and select "No Border".

Color.
POSTER will keep each picture in the maximum color 'depth' that it is available.    256 
color pictures are always kept internally in 256 color mode; True-color pictures are 
always kept internally in true-color mode.    The following rules apply:
1. Pictures are always displayed in the maximum color depth that you have selected for 
your display (usually 16 color or 256 color, but poster will support true-color as well).
2. Pictures are always printed in the maxium color depth that your printer will support, 
regardless of how they are displayed.    Example: You import a 256-color bitmap, but 
your display is only setup for 16 colors. POSTER will display it in 16 colors, but will print 
it in 256 colors.
3. If you have multiple 256-color pictures displayed simultaneously and your display is 
setup for 256-color mode, the colors may not all be displayed correctly, because 
windows can only display 256 DIFFERENT colors at once. However, the pictures WILL 
print correctly, because most color printers are not limited to 256 colors.



Setting Page Size and Margin. 

POSTER works with a single page, which is normally a standard size of 7 1/2 x 10 
inches, plus a 1/2 inch margin on each edge, giving a total size of 8 1/2 x 11 inches.      
This is called the SCREEN SIZE. You can use this page either vertically, or horizontally; 
you select this on the 'PAGE' menu.    POSTER always displays the entire page at once.

When you set font sizes - such as 1 inch, the default - those sizes are relative to the 
SCREEN SIZE: a single sheet of 8 1/2 x 11 inch paper.

When you print the poster, you tell POSTER how big to print it - that is - how big to scale
up the "Screen Size". (See Printing a Poster).    This is called the PRINT SIZE. The 
poster is only enlarged when it is printed.

Text Margin.

The "Text Margin" is the space between the edge of the printed area, and the start of 
the text. The following rules apply:
1. The margin is the same on all sides.
2. The margin defaults to 0.1 inches (3 mm).
3. If you are using SIMPLE BORDERS, the margin is relative to the innermost boarder, 
NOT the end of the printed page.
4. If you are using a BORDER or BACKGROUND from a file or from the clipboard, the 
margin is relative the end of the printed page.    
5. If you IMPORT a BORDER from a METAFILE, the text margin is automatically set to 
0.5 inches for you.
6. You may change the text margin at any time, using "Page"->"Size and Margin".

Custom Page Sizes.

If you don't like the standard 7 1/2 x 10 size (or a multiple of it), you can set a custom 
page size in the 'PAGE' menu.    This can be any size up to 10 x 10.    This is called the 
"Screen size", as it controls the size of the poster on the screen.
This effectively changes the SHAPE of the poster.    When you print the poster, you can 
scale it up as big as you like.

Example: If you wanted a printed poster size of 40 x 40, you would set a page size of    
10    x 10 inches.    Then, when you printed it, you would print it at 4x, giving 40 x 40.

NOTE: POSTER always adds a 1/2 inch margin along each edge of the page when the 
poster is printed. (in the above example, the final poster would be 40.5 x 40.5 inches).

Banners.

The "Edit" "Banner" command automatically sets the SCREEN page size to 1.5 inches 
by 21 inches.    It also sets the print scale to 5x.    When the poster is printed, it will print 
at 7.5 inches x 105 inches (19 cm. x 266 cm.)
    
You can make the banner narrower by setting "Custom Size" to a size less than 21 
inches.    You cannot make the banner wider.



Adding a Border.

You can have POSTER add a simple border or a fancy border to the entire poster.    The
border is printed at the end of the standard poster size, which is 7.5 x 10 inches.    (If 
you have specified a custom page size, the border is printed    within that size).

From File.
This option allows you to import any WMF (windows metafile) or BMP (bitmap file) as a 
border.    The graphic in the file is automatically stretched to fill the entire page.    The 
graphic is used both as a border, and as a background.    Although typing in text may 
temporarily blank the background, it is still there.    A "Refresh" command will redraw it, 
and it will always print.

To change the background, import a new one, or select "No Border" from the "Simple 
Borders" dialog box.

POSTER includes a few WMF files with samples of fancy borders.    If you register 
poster, you will receive a disk full of fancy borders.

NOTE: when you add a WMF file as a border, the TEXT MARGIN is automatically set to
0.5 inches to accommodate a fancy border.    You may reset it with the "Page"->"Size & 
Margin" menu item.

From Clipboard.
This option allows you to paste a metafile from the clipboard into the border.    This is 
identical to importing a WMF file as a border.
Fancy borders are clipart borders which are pasted from the clipboard.    The clipart 
must be in the windows metafile ("picture") format.    It can be imported from a program 
like Corel Gallery, or created in a program like Draw.
The border is always expanded to fit the entire screen.
Corel Gallery is recommended as an excellent choice of hundreds of borders (as well as
thousands of pieces of clip art) for less than $30.

Simple borders.

RECTANGLE: A simple rectangle.    You may have 1, 2, or 3 nested rectangles, and the 
rectangles can be narrow, medium, or wide.    Try experimenting with the different 
settings.    Text is automatically fit within the smallest rectangle. The TEXT MARGIN 
becomes relative to the smallest rectangle, rather than to the end of the printed area.

ROUNDED RECTANGLE:    Identical to 'RECTANGLE', but the corners of the rectangle 
are rounded.

Color.    
Border color is treated similarly to text color.    Your printer will print the border in color if 
it can. The Color only applies to SIMPLE borders.



Setting Options.

The options are global, and effect any document edited by POSTER.
Options are not saved by SAVE, and are not reloaded by OPEN.

Display Non-Printable characters.
This option displays a paragraph mark where ever a carriage return has been entered. 
(Sometimes this mark may not be visible if it is off the side of the page). This is to help 
you remember where you have hard line breaks.    These marks are NOT printed with 
the poster is printed.
This option defaults to OFF.

Display Bounding-box around graphics.
This option displays a dashed line around a graphic which has been pasted into the 
document.    The graphic can be resized with the RESIZE option.
The dashed line is NOT displayed when the poster is printed.
This option defaults to ON.

Don't display metafiles.
When set, this option bypasses the display of metafiles on the screen - however, the 
bounding box is always displayed.    This option is used if the redraw of a metafile takes 
a lot of time.    
The metafile is ALWAYS printed when the poster is printed.
This option defaults to OFF.

Metric.
When this is set, all measurements are expressed in centimeters, rather than inches.    
The default font menu shows fonts in increments of 0.5 cm, and the 
Text->Bigger/Smaller entries increment the text by 0.5 cm.

NOTE: If you have setup your machine to use METRIC measurements, POSTER 
automatically comes up in METRIC mode.    To do this, use the "International" settings in
the "Control Panel". 

You may switch between Metric and English measurements at any time.



menu

FILE:        File operation menu
        NEW:            Create a new poster
      OPEN:          Load a previously saved poster created by SAVE or SAVEAS
      SAVE:          Save the current poster in current file (default is UNTITLED)
      SAVEAS:      Save the current poster in a new file
      IMPORT GRAPHIC      Imports a *.bmp or *.wmf file    at the cursor position.
      PRINT:        Print the poster on the printer - see printing
      EXIT:          Quit the poster program

EDIT:          Editing operations menu
        UNDO:          Undo the last major change
        CUT:            Copy the selection to Windows clipboard and then delete it.
        DELETE:      Delete the current selection
        COPY:      Copy to the Windows clipboard
        PASTE:      Insert contents of Windows clipboard

Text - insert at the current cursor: using the current font and size.
This is equivalent to typing in the text characters.
Bitmap - paste the picture in at the current cursor position.
Other - Any other format is ignored.

FONT:          Change to specified font
If no text is selected, this applies to all subsequent characters entered.
If text is selected, all text in the selection is changed to the specified font,
but attributes like Bold and Size are not changed.

TEXT:          Change the appearance of the text. 
If the text is highlighted, it applies to the highlighted text.
If the text is not highlighted, it applies to the next characters to be typed.

        NORM:          Change to no bold, no italic, no underline
        BOLD:          Toggle between bold and non-bold
        ITAL:          Toggle between italic and non-italic
        ULINE:        Toggle between underlined and not
        CENTER:      Center the current line or selected lines

Only the 1st character of a line is checked for this.
        LEFT:          Left align the current or selected lines

Only the 1st character of a line is checked for this.
        RIGHT:        Right align the current or selected lines

Only the 1st character of a line is checked for this.
        SIZE:          Change the    character sizes, but not the fonts or bold and italics.

          These sizes are in inches for a single 8.5 x 11 inch page.
          When the page is printed, the characters scale up by the scale factor.
          So, if you print at '2x', a 1 inch character is printed 2 inches high.

PAGE:          Change the appearance of the page
        TOP:          Start the text at the top of the poster
        CENTER:      Center all text on the poster
        BOTTOM:      Align last line at the bottom of poster
        BORDER:      Select the border pattern
        VERTICAL:      Select Portrait orientation. Poster is taller than it is wide
        HORIZONTAL:      Select Landscape orientation. Poster is wider than it is tall
        Page size and margin:    Sets a page size other than 8.5 x 11.    See 'Setting Page 
Size'.



HELP:          Get Help    
        HELP:          Bring up help on POSTER    
        ABOUT:        About the POSTER program    



Keyboard help.

The only special keys recognized by Poster are:
F1 - call for Help
F3 - SAVE
F5 - Redraw. Use this when the display doesn't look quite right.
                Sometimes POSTER does not properly update the screen after a delete
              or insert - this will generally fix the problem.
ESC - If text is selected, deselect it.
The cursor keys will move the cursor.
Home - move to start of current line.
End - move to end of current line.
PageUp - move to the start of the poster.
PageDown - move to the end of the poster.
Del - delete the next character, or the current selection.






